Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

© December 2003

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

When using your telephone equipment, basic safety precautions should always be followed to reduce the risk of fire, electric shock and injury to persons, including the following:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 2.5A minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD
Instructions for Care and Operation

The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don't drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the vents.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

   | Do not turn off the power until you properly shut down all programs. |
   | Do not turn off any peripheral devices when the computer is on.       |
   | Do not disassemble the computer by yourself.                        |
   | Perform routine maintenance on your computer.                       |

5. **Take care when using peripheral devices.**

   | Use only approved brands of peripherals.                          |
   | Unplug the power cord before attaching peripheral devices.        |
Preface

Power Safety
The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC adapter or car adapter).

![Power Safety Warning]

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

---

**Do not plug in the power cord if you are wet.**

**Do not use the power cord if it is broken.**

**Do not place heavy objects on the power cord.**
Battery Precautions

• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Recharge the batteries using the computer’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Caution

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Preface

Touch Panel Care
• Touch Panels are made of glass, so do not subject them to heavy shock or stress.
• Do not place heavy objects on the Touch Panel.
• Please use a dry soft cloth when cleaning (do not use any organic solvent acid or alkali solution).

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:
• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying bag.
5. The AC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the computer in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the computer** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the computer in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:

- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.
# Contents

Notice ...........................................................................I  
Trademarks ..........................................................I  
FCC Statement ...................................................II  
Instructions for Care and Operation ................. IV  
Power Safety ..................................................... VI  
Battery Precautions ..........................................VII  
Touch Panel Care .......................................... VIII  
Cleaning ........................................................ VIII  
Servicing ........................................................ VIII  
Travel Considerations ........................................... IX  
Remember to: ......................................................... I-XI  

## Introduction

Overview ............................................................ 1-1  
Advanced Users .....................................................1-1  
Beginners and Not-So-Advanced Users .................1-1  
Warning Boxes .......................................................1-2  
Not Included ...........................................................1-2  
System Software .....................................................1-2  
Quick Start Guide .....................................................1-3  
System Map .............................................................1-4  
Model Differences ..................................................1-4  
Getting to Know Your Computer ....................... 1-5  

Top View ........................................................................... 1-6  
The LCD Swivel Screen ........................................... 1-7  
The LCD Swivel Screen with LCD Open ................. 1-8  
PC Camera ............................................................ 1-9  
LED Power Indicators ........................................... 1-9  
Cover Sensors ...........................................................1-10  
LCD Swivel & Side Hinges ....................................... 1-11  
Power Button ...................................................... 1-11  
Stereo Speakers .................................................. 1-11  
Keyboard ............................................................ 1-12  
TouchPad & Buttons .......................................... 1-12  
Microphone ........................................................... 1-12  
Front View ..................................................................... 1-13  
LCD Latches ....................................................... 1-13  
Microphone-In Jack ............................................ 1-13  
Headphone-Out Jack .......................................... 1-14  
Infrared Transceiver ........................................... 1-14  
LED Status Indicators .......................................... 1-14  
Hot-Key Buttons ................................................. 1-15  
Left Side View ....................................................... 1-16  
Security Lock Slot .............................................. 1-16  
Vent ................................................................. 1-16  
Stylus Pen Holder ............................................... 1-16  
Right Side View ..................................................... 1-17
Preface

4-in-1 Flash Card Reader ....................................1-17
2 * USB 2.0 Ports ................................................1-18
PC Card Slot ........................................................1-18
Rear View ...............................................................1-19
External Monitor (CRT) Port ..............................1-19
RJ-45 LAN Jack ..................................................1-19
RJ-11 Phone Jack ................................................1-20
DC-In Jack ..........................................................1-20
Vent .....................................................................1-20
Bottom View ..........................................................1-21
Stylus Pen Holder ................................................1-21
Battery .................................................................1-21
Wireless LAN (Network) Module ......................1-22
Hard Disk Drive ..................................................1-22
Vent .....................................................................1-22

Using The Computer
Overview ..........................................................2-1
The Power Sources ................................................2-2
AC Adapter .............................................................2-2
Battery ......................................................................2-2
Recharging the Battery with the AC Adapter ......2-3
Proper handling of the Battery Pack .................2-3
Turning on the Computer .......................................2-4
LED Indicators ........................................................2-5
LED Power Indicators ..........................................2-5
LED Status Indicators ..........................................2-6
Hard Disk Drive ..................................................2-7
The Floppy Disk Drive (Optional) .........................2-8
Inserting/Removing Floppy Disks .......................2-8
CD Device/DVD Device (Optional) ......................2-9
Optional CD/DVD Device Options ......................2-10
Loading CDs or DVDs ..........................................2-10
Handling CDs or DVDs ........................................2-11
DVD Regional Codes ..........................................2-12
Changing DVD Regional Codes .........................2-13
4-in-1 Card Reader ...............................................2-14
PC Card Slot ........................................................2-15
Inserting and Removing PC Cards .....................2-15
Hot-Keys ...............................................................2-16
The Keyboard .....................................................2-17
The Function Keys ..............................................2-17
Numeric Keypad ..................................................2-18
Touch Panel (Model A Only) ..............................2-19
TouchPad and Buttons/Mouse .........................2-22
Configuring the TouchPad and Buttons ..............2-23
Adding a Printer ......................................................2-24
USB Printer ..........................................................2-24
Install Instructions: ..............................................2-24
Parallel Printer .....................................................2-24
Advanced Controls
Overview .............................................................. 3-1
Advanced Video Controls ........................................ 3-2
  Opening the LCD ................................................. 3-2
Video Driver Controls ............................................. 3-3
  Making Adjustments for the Display ...................... 3-3
Display Properties .................................................. 3-4
  S3 Control Taskbar Utility ..................................... 3-5
  S3 Advanced Display Properties ............................ 3-5
Display Devices ...................................................... 3-7
  Power Management Features ................................. 3-8
    Advanced Configuration and Power Interface ........... 3-8
Enabling Power Options ......................................... 3-9
Power Schemes ...................................................... 3-10
  Conserving Power (System) .................................. 3-11
Hibernate Mode vs. Shutdown ............................... 3-11
  Standby Mode vs. Hibernate Mode ......................... 3-11
Standby ............................................................... 3-12
Hibernate ............................................................ 3-12
Configuring the Power Button ............................... 3-13
Battery Information ................................................. 3-14
  New Battery ...................................................... 3-14
Battery Life .......................................................... 3-14
Battery FAQ .......................................................... 3-15
Via Power Saver 2.0 .............................................. 3-16
PC Camera ............................................................ 3-17
PC Camera Audio Setup ....................................... 3-17
AMCAP ............................................................... 3-19
Set Capture File ................................................... 3-19
Wireless LAN Module ........................................... 3-20

Drivers & Utilities
Overview .............................................................. 4-1
What to Install ...................................................... 4-2
New Hardware Found .......................................... 4-2
Authorized Driver Message ................................. 4-3
Version Conflict Message ..................................... 4-3
Updating/Reinstalling Individual Drivers ............... 4-3
Driver Installation ................................................ 4-4
Automatic Driver Installation ............................... 4-4
Windows XP ........................................................ 4-6
  VIA 4 in 1 ........................................................ 4-6
  VIA VGA (Video) ............................................... 4-6
  VIA LAN ......................................................... 4-7
  Modem .......................................................... 4-7
  PC Card/PCMCIA .............................................. 4-7
  PC Camera ...................................................... 4-8
  Wireless LAN .................................................. 4-8
  Touch Panel (Model A Computers) ....................... 4-9
Preface

Infrared (VIA FIR) ................................................4-9
TouchPad ............................................................4-10
VIA USB 2.0 .......................................................4-10
VIA Power Saver ................................................4-10
VIA Audio ...........................................................4-10

BIOS Utilities
Overview ..................................................................5-1
Important BIOS Settings ..........................................5-2
The Power-On Self Test (POST) .............................5-3
FirstWare Utilities ..................................................5-4
POST Screen ............................................................5-5
Failing the POST ....................................................5-6
Fatal Errors ............................................................5-6
Non-Fatal Errors ...................................................5-6
The Setup Program ...................................................5-7
Entering Setup ........................................................5-7
Setup Screens .........................................................5-7
Main Menu ...............................................................5-8
System Time & Date (Main Menu) .........................5-8
Primary Master (Main Menu) .................................5-9
QuickBoot Mode: (Main Menu) ..............................5-9
Summary screen: (Main Menu) ...............................5-9
Advanced Menu .....................................................5-10
Firstware Language: (Advanced Menu) .................5-10
Firstware Authentication Level:
(Advanced Menu) .................................................. 5-11
Firstware Video Mode: (Advanced Menu) .............5-11
Boot-time Diagnostic Screen: (Advanced Menu) . 5-11
Advanced Chipset Control: (Advanced Menu) .... 5-12
I/O Device Configuration: (Advanced Menu) ...... 5-12
Legacy USB Support: (Advanced Menu) .............5-13
Large Disk Access Mode: (Advanced Menu) ..... 5-13
Installed O/S: (Advanced Menu) ......................... 5-13
Reset Configuration Data: (Advanced Menu) ......5-13
Security Menu .........................................................5-14
Set Supervisor Password (Security Menu) ............5-15
Set User Password (Security Menu) ......................5-15
Fixed disk boot sector: (Security Menu) ...............5-15
Virus check/System backup reminder:
(Security Menu) ..................................................... 5-15
Password on boot: (Security Menu) ..................... 5-16
Power Menu ...........................................................5-17
PC Beep: (Power Menu) ........................................ 5-17
Turbo/DeTurbo (Power Menu) .............................. 5-17
Boot Menu .............................................................5-18
Boot Menu .............................................................5-18
Phoenx FirstWare Utilities ................................. 5-19
Exit Menu ..............................................................5-20
Upgrading The Computer
Overview ................................................................. 6-1
  When Not to Upgrade .............................................. 6-2
Removing the Battery ................................................. 6-3
  Battery Removal Process ......................................... 6-3
Upgrading the Hard Disk Drive ................................. 6-4
  Hard Disk Upgrade Process ...................................... 6-4
Upgrading the System Memory (RAM) ....................... 6-5
  Memory Upgrade Process ........................................ 6-5
Upgrading the Processor ............................................ 6-7

Troubleshooting
Overview ................................................................. 7-1
  Basic Hints and Tips ............................................... 7-2
Backup and General Maintenance .............................. 7-3
Viruses ..................................................................... 7-4
Upgrading and Adding New Hardware/Software ......... 7-5
Power ...................................................................... 7-7
Display ..................................................................... 7-9
Boot Password ......................................................... 7-10
Audio ...................................................................... 7-11
CD Device (Optional) ................................................ 7-12
Keyboard .................................................................. 7-13
Operation ................................................................ 7-14

Appendix A. Model A Specifications
Processor Options ................................................... A-1
Memory ................................................................. A-1
Core Logic ............................................................. A-1
Structure ............................................................... A-1
Security ................................................................. A-1
BIOS ..................................................................... A-1
LCD ....................................................................... A-1
Storage .................................................................... A-2
PC Card ................................................................. A-2
Audio ..................................................................... A-2
Keyboard ............................................................... A-2
Pointing Device ...................................................... A-2
Interface ............................................................... A-3
Power ..................................................................... A-3
Indicators ............................................................... A-3
Buttons ................................................................. A-3
Environmental Spec ................................................. A-4
Physical Dimensions .............................................. A-4
Weight .................................................................... A-4
Optional ............................................................... A-4

Appendix B. Model B Specifications
Processor Options .................................................. B-1
Memory ................................................................. B-1
Preface

Core Logic ............................................................... B-1
Structure ............................................................... B-1
Security ................................................................. B-1
BIOS ........................................................................ B-1
LCD ......................................................................... B-1
Storage ..................................................................... B-2
PC Card ................................................................... B-2
Audio ....................................................................... B-2
Keyboard ................................................................... B-2
Pointing Device ....................................................... A-2
Interface ................................................................... B-3
Power ....................................................................... B-3
Indicators ................................................................. B-3
Buttons ..................................................................... B-3
Environmental Spec ................................................ B-4
Physical Dimensions .............................................. B-4
Weight ..................................................................... B-4
Optional ..................................................................... B-4
Chapter 1: Introduction

Overview
This manual refers to the hardware and essential software required to run your computer. Depending on how your system is configured, some or all of the features described may already be set up. This chapter covers:

• The Manual — how to use it
• System Map — navigating around your computer

Advanced Users
If you are an advanced user you may skip over most of this manual. However you may find it useful to refer to the “What to Install” on page 4 - 2, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. You may find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then you should try to look through all the documentation. Do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin.
Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows XP etc.) have their own manuals, as do applications (e.g. word processing, spreadsheet and database programs). If you have questions about the operating systems or programs then please consult the appropriate manuals.

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find this manual refers to the following operating systems:

- Microsoft Windows XP Professional & Home Editions
Quick Start Guide

This guide assumes that you are already familiar with computers and can tell at a glance what and where all the key components are. If you are not that comfortable with this type of device, then please refer to the following pages, which give an overview of the system.

It is still best to review these steps, before taking any action. If there is anything you are not sure about, then please refer to the appropriate chapter before continuing.

Unless you need to install an operating system, your computer should be ready to work right out of the box. Before you begin please follow the safety instructions in the Preface.

1. Remove all packing materials.
2. Securely attach any peripherals you want to use with the computer (e.g. keyboard and mouse) to their ports.
3. Attach the AC adapter to the DC-in jack at the rear of the computer (see “Rear View” on page 1 - 19), then plug the AC power cord into an outlet, and connect the AC power cord to the AC adapter.
4. Raise the LCD Swivel Screen to a comfortable viewing angle.
5. Press the power button to turn “On”.

Peripheral Devices

Please note that peripherals (printers, digital cameras, etc.) which attach to your computer by USB ports may be connected after Windows is up and running. All other peripherals must be connected before you turn on the system.
System Map

Your computer has a lot of built-in features. Most of these are enabled by your operating system. Further explanations of the various subsystems are covered in the chapter or pages indicated.

Model Differences

This notebook series includes two different model types. Model A includes a Touch Panel screen, Model B does not. The specifications for each model are listed in “Appendix A. Model A Specifications” on page A - 1 and “Appendix B. Model B Specifications” on page B - 1.

In addition both Model A and Model B have two different designs as pictured on the following page.
Getting to Know Your Computer
The following graphics will help you to become familiar with the basic functions, and to learn the location of the various ports and components of your computer.

Design Differences
This manual refers to the two notebook designs pictured on this page.

The designs vary slightly in external design. Photographs used throughout this manual are of Design I.

Figure 1 - 1
Design Differences
To open the LCD display:
1. Place the computer on a stable surface.
2. Press the latches in the direction of the arrows (press in) to release the top cover.
3. Lift the top cover to reveal the LCD Swivel Screen and keyboard.
4. Adjust the LCD Swivel Screen to a comfortable viewing angle.
5. The LED indicators show the power and battery status of the computer.
6. If you wish to operate the computer in Tablet Mode see page 1 - 7.
The LCD Swivel Screen

You can use the computer either in **Notebook Mode**, or in **Tablet Mode**. To put the computer into **Tablet Mode**:

1. Unlock the LCD side hinges 1 & 2 by moving them in the direction of the arrows.
2. Carefully rotate the LCD fully in the direction indicated by the arrow 3, then lock the side hinges 1 & 2.
3. Move latches 4 & 5 in and to the left (if they are not already in this position), then push the LCD down to lock it in position.

*Figure 1 - 3*
Rotating the LCD Swivel Screen
Introduction

1 - 8 The LCD Swivel Screen

Figure 1 - 4
Top View with LCD Panel Open

1. Built-In PC Camera (Optional)
2. LCD Swivel Screen
3. LED Power Indicators
4. Cover Sensors
5. LCD Swivel Hinge
6. LCD Side Hinges
7. Power Button
8. Speakers
9. Keyboard
10. TouchPad and Buttons
11. Built-In Microphone

1 - 8 The LCD Swivel Screen
PC Camera
If you have purchased the optional PC Camera, make sure you install the software application (see “PC Camera” on page 4 - 8 & 3 - 17).

LCD Swivel Screen
The computer comes with a TFT (Thin Film Transistor), Liquid Crystal Display screen (see “LCD” on page A - 1 or “LCD” on page B - 1 for details). The screen can rotate and tilt for best visibility in Notebook Mode, and flip for use in Tablet Mode. The screen may be rotated to appear in Landscape Mode or Portrait Mode by means of the video driver (see “S3 Control Taskbar Utility” on page 3 - 5) or “Q” Hot-Key (see “Q Key Functions” on page 2 - 16).

If your computer is Model A the screen also acts as a Touch Panel when the driver is installed (see “Touch Panel (Model A Computers)” on page 4 - 9). You can use the stylus pen provided to point directly to objects on the screen in much the same way as you would use your mouse as the pointing device (see “Touch Panel (Model A Only)” on page 2 - 19).

LED Power Indicators
These indicators display the system power status, and battery status of the computer (see “LED Power Indicators” on page 2 - 5).
Introduction

Cover Sensors
These switches act as sensors to tell when the LCD Swivel Panel is closed, in Notebook Mode, or in Tablet Mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Left LCD Cover Sensor</th>
<th>Right LCD Cover Sensor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notebook Mode (LCD Open)</td>
<td>Press the left LCD cover sensor to trigger the default power saving state (&quot;When I close the lid of my portable computer&quot;).</td>
<td>Press and hold the right LCD cover sensor, and simultaneously press/tap the “Q” key to trigger the functions as per “Q Key Functions” on page 2 - 16.</td>
</tr>
<tr>
<td>Notebook Mode (LCD Closed)</td>
<td>Close the LCD to automatically trigger the default power saving state (&quot;When I close the lid of my portable computer&quot;).</td>
<td>N/A</td>
</tr>
<tr>
<td>Tablet Mode</td>
<td>N/A</td>
<td>If the LCD is fully locked down, the right LCD cover sensor will be depressed automatically. Press/tap the “Q” key to trigger the functions as per “Q Key Functions” on page 2 - 16.</td>
</tr>
</tbody>
</table>

See **Lid** in *Figure 3 - 10 on page 3 - 13* for information on setting the power saving state. See the sidebar for the power scheme setting recommendation.

Lid Button
It is recommended that you set the lid (left LCD cover sensor) power button to “Do nothing”.

This will prevent accidentally triggering a power saving mode when you rotate the LCD swivel screen.

Table 1 - 1
Cover Sensor Functions
**LCD Swivel & Side Hinges**
Release the side hinges in the direction indicated by the arrows on the top panel, and swivel the LCD panel in the direction indicated on the top panel.

**Power Button**
Press this button to turn your computer On or Off (see “Turning on the Computer” on page 2 - 4). This button may also be used as a suspend/resume key, once configured as such in the power management control panel of your operating system (see “Configuring the Power Button” on page 3 - 13).

**Stereo Speakers**
Two built-in speakers provide rich, stereo sound.

---

*Forced Off*
If the system "hangs", and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

*Shutdown*
Please note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.
Keyboard
The computer has a “Win Key” keyboard including an embedded numeric keypad. It has the same features as a full-sized desktop keyboard and can easily be replaced with a different language keyboard should you desire.

TouchPad & Buttons
The pointing device features a sensitive glide pad for precise movements. It functions the same way as a two-button mouse. The right TouchPad button is the same as the right mouse button; the left TouchPad button is the same as the left mouse button (see “Configuring the TouchPad and Buttons” on page 2 - 23).

Microphone
Record on your computer with the built-in microphone.
Introduction

Front View

1. LCD Latches
2. Microphone-In Jack
3. Headphone-Out Jack
4. Infrared Transceiver
5. Scroll/Enter Wheel
6. LED Status Indicators
7. 3 * Hot-Key Buttons (Esc, Tab, & “Q” Rotate)

Infrared Communication

The Infrared transceiver operates on a “Line of Sight”. Make sure nothing is blocking the “Line of Sight” between your system’s transceiver and the destination’s transceiver.

LCD Latches

Slide the LCD latches to the right to release the LCD panel (slide to the left to lock the panel down in tablet mode).

Microphone-In Jack

Record on your computer with an external microphone (the microphone-in jack is colored pink).
Headphone-Out Jack
Headphones may be connected through this jack (the headphone-out jack is colored green). **Note**: Set your system’s volume to a reduced level before connecting to this jack.

Infrared Transceiver
The infrared transceiver enables communication between the computer and another similarly equipped device, and is 4M bps FIR, IrDA 1.1 compliant. For further information please refer to the manual of the device you wish to connect.

Scroll/Enter Wheel
The wheel key works as a scrolling key (in much the same way as the keyboard arrow keys) if moved to the left or right. If you push the key in it will act as an Enter/Return key.

LED Status Indicators
These display the system’s operational status. Refer to “LED Power Indicators” on page 2 - 5 for more information on what the lights mean.
Hot-Key Buttons
The three Hot-Key buttons include Tab & Esc keys (these keys are particularly useful in Tablet Mode), and a “Q” key to rotate the screen between Portrait and Landscape modes it also acts as a power button (see “Q Key Functions” on page 2-16 for full details).

Windows Media Player and Screen Rotation
If you are playing a DVD/VCD video in Windows Media Player, do not rotate the screen while playing the video. If you wish to rotate the screen, quit the Media Player program first, rotate the screen, then open the player to play the video.
Introduction

**Figure 1 - 6**

Left Side View

1. Security Lock Slot
2. Vent
3. Stylus Pen Holder

**Security Lock Slot**
To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.

**Vent**
This enables airflow to prevent the computer from overheating.

**Stylus Pen Holder**
Keep the stylus pen in this holder when not in use.

Overheating

To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
**Right Side View**

**4-in-1 Flash Card Reader**
The card reader allows you to use four of the most popular digital storage cards. The formats which can be read include:

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- SM (SmartMedia Card)

See “4-in-1 Card Reader” on page 2 - 14.

**External CD Devices**
External CD devices (e.g. CD-ROM drives, DVD-ROM drives, CD-RW drives and Combination drives) may be plugged in to either of the USB ports.

**Figure 1 - 7**
Right Side View
1. 4-in-1 Flash Card Reader
2. 2 * USB 2.0 Ports
3. PC Card Slot

**USB Cables**
Make sure that your USB cable connector is orientated the correct way before inserting it into the USB Port. It will only fit one way (don’t force it).
**Introduction**

**2 * USB 2.0 Ports**
These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external DVD devices, CD devices, HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).

**PC Card Slot**
The 3.3V/5V slot may be used for a Type-II PC Card (PC Cards were also previously referred to as PCMCIA) and fully supports Cardbus. Refer to “PC Card Slot” on page 2 - 15 for more information.

---

**Optional USB 2.0 CD Device**
If your purchase includes the external USB 2.0 CD Device, you can connect it to the USB port.

**USB Cables**
Make sure that your USB cable connector is orientated the correct way before inserting it into the USB Port. It will only fit one way (don’t force it).
Rear View

External Monitor (CRT) Port
Connect an external VGA monitor (CRT) to this port to allow simultaneous display on the LCD and external VGA monitor (see “Display Devices” on page 3 - 7).

RJ-45 LAN Jack
This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
Introduction

**RJ-11 Phone Jack**
This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.

*Note:* Broadband (e.g. ADSL) modems usually connect to the LAN port.

**DC-In Jack**
Plug the supplied AC adapter into this jack to power your computer.

**Vent**
This enables airflow to prevent the computer from overheating.
**Bottom View**

**Stylus Pen Holder**
The stylus pen fits in this holder.

**Battery**
See *“Battery Information” on page 3-14* for information on battery use and care.

---

**Figure 1 - 9**

**Bottom View**
1. Stylus Pen Holder
2. Battery
3. Modem & Wireless LAN Module Cover
4. Hard Disk Cover
5. RAM Cover
6. CPU Cover
7. Vent

---

**CPU**
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

---

**Overheating**
To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
Wireless LAN (Network) Module
If your computer has the 802.11b Wireless LAN module the antenna and other components are not externally visible (please check with your service representative). If your configuration includes the module(s), make sure to install the driver (see “Wireless LAN” on page 4 - 8). Make sure the wireless module is OFF (the Wi-Fi LED is off) when you are using the computer aboard aircraft (see sidebar note).

Hard Disk Drive
The internal hard disk drive is used to store your data. See page 6 - 4 for information on upgrading/replacing your hard disk drive.

Vent
This enables airflow to prevent the computer from overheating.

Drive Warning
Don’t try to remove the hard disk (HDD) while the system is on. This could cause data loss or damage. Unauthorized removal or tampering with the HDD may violate your warranty. If you are in doubt, consult your service representative.
Chapter 2: Using The Computer

Overview
To learn more about using your computer, please read this chapter.

This chapter includes:

- The Power Sources
- Turning on the Computer
- The LED Indicators
- The Hard Disk Drive
- The Floppy Disk Drive (Optional)
- CD/DVD Device (Optional)
- 4-in-1 Card Reader
- The PC Card Slot
- The Hot-Keys
- The Keyboard
- The Touch Panel
- The TouchPad & Buttons/Mouse
- Adding a Printer (general guidelines)
The computer can be powered by either an AC adapter or a battery pack.

**AC Adapter**

Use only the AC adapter that comes with your computer. The wrong type of AC adapter will damage the computer and its components.

1. Attach the AC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC adapter.
3. Raise the LCD Swivel Panel to a comfortable viewing angle.
4. Press the power button to turn “On”.

**Power Button as Standby or Hibernate Button**

Fully ACPI-compliant OS’s such as Windows XP can use the “Power Options” control panel to set the power button to send the system into Standby or Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on page 3 - 13 for details).
Battery
The battery allows you to use your computer while you are on the road or an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging.

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 14.

Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 2 - 5 for information on the battery charge status, and to “Battery Information” on page 3 - 14 for more information on how to maintain the battery pack.).

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Standby/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

If the computer is in Tablet Mode you can use the “Q” Hot-Key as a power button (see “Q Key Functions” on page 2 - 16 for full details).
LED Indicators

There are two sets of LED indicators (LED Power Indicators and LED Status Indicators) on your computer that will display helpful information about the current status of the computer. The LED Power Indicators are also visible when the top of your computer is closed (in Notebook Mode).

LED Power Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Power Icon]</td>
<td>Orange</td>
<td>The AC Adapter is plugged in</td>
</tr>
<tr>
<td>![Power Icon]</td>
<td>Green</td>
<td>The computer is on</td>
</tr>
<tr>
<td>![Power Icon]</td>
<td>Blinking Green</td>
<td>The computer is in standby mode</td>
</tr>
<tr>
<td>![Battery Icon]</td>
<td>Orange</td>
<td>The battery is being charged</td>
</tr>
<tr>
<td>![Battery Icon]</td>
<td>Green</td>
<td>The battery is fully charged</td>
</tr>
<tr>
<td>![Battery Icon]</td>
<td>Blinking Orange</td>
<td>The battery has reached critically low power status</td>
</tr>
</tbody>
</table>

*Table 2-1 LED Power Indicators*
### LED Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="WLAN Module" /></td>
<td>Green</td>
<td>The WLAN Module is On</td>
</tr>
<tr>
<td><img src="image" alt="Hard Disk" /></td>
<td>Green</td>
<td>Hard Disk/System activity</td>
</tr>
<tr>
<td><img src="image" alt="Number Lock" /></td>
<td>Green</td>
<td>Number Lock is activated</td>
</tr>
<tr>
<td><img src="image" alt="Caps Lock" /></td>
<td>Green</td>
<td>Caps Lock is activated</td>
</tr>
<tr>
<td><img src="image" alt="Scroll Lock" /></td>
<td>Green</td>
<td>Scroll Lock is activated (to activate press Fn &amp; ScrLk)</td>
</tr>
</tbody>
</table>

*Table 2 - 2 LED Status Indicators*
Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5" IDE hard disk drives with a height of 9.5 mm.

The hard disk 1 is accessible from the bottom of your computer as seen below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.

Figure 2 - 1
Hard Disk Location
The Floppy Disk Drive (Optional)

The optional external 1.44 MB, 3.5" USB floppy disk drive can connect to any of the USB ports on the computer. By default it is drive “A:” and can be used as a boot device if properly set in the BIOS (refer to “Boot Menu” on page 5 - 18). If your purchase configuration does not include this option you can purchase a USB floppy disk drive from a computer store.

Inserting/Removing Floppy Disks
When using the floppy drive, always insert your floppy diskette with the label-side facing up. To remove the inserted diskette, press the eject button on the top-right corner of the floppy drive.

Media Warning
Don't try to remove a floppy disk while the system is accessing it. This may cause the computer to “crash” and damage your data.
CD Device/DVD Device (Optional)

The optional external CD/DVD Device is USB 2.0 compliant and can connect to any of the USB ports on the computer. If your purchase configuration does not include this option you can purchase a USB CD/DVD Device from a computer store.

When used with your computer the device must be powered by an AC power source via the AC adapter. When used with the AC adapter make sure the power switch is set to EXT (external power).
Optional CD/DVD Device Options
The optional external CD device is available in CD-ROM, or DVD-ROM, or CD-RW, or Combination CD-RW and DVD-ROM drive configurations. The CD Device is usually labeled “Drive D:”, and may be used as a boot device if properly set in the BIOS (“Boot Menu” on page 5 - 18).

Loading CDs or DVDs
To insert a CD/DVD, press the eject button and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The LED indicator will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency tray release hole to open the tray.
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CD-ROMs/DVD-ROMs can be accessed.

Remember to:
• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject
If you need to manually eject a CD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. However please do NOT use a sharpened pencil or similar object that may break and become lodged in the hole.
Using The Computer

DVD Regional Codes
DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module with another computer.

Figure 2 - 3
DVD Regional Codes
(Windows XP)
Changing DVD Regional Codes

Go to the Control Panel in *Windows XP/Windows 2000* and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties menu, and select the DVD Region (tab) to bring up the control panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 12.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table 2 - 3 DVD Regional Coding*
Using The Computer

4-in-1 Card Reader

The 4-in-1 Card Reader allows you to use four of the most popular digital storage cards.

To read from the card, simply insert the card into the slot and it will appear as a removable device. The formats which can be read include:

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- SM (SmartMedia Card)

Note that SmartMedia Cards should be inserted as illustrated in Figure 2 - 4.
PC Card Slot

The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC Card. Make sure you install the driver for the PC Card (see “What to Install” on page 4 - 2).

Inserting and Removing PC Cards

- Align the PC Card with the slot and push it in until it locks into place.
- To remove a PC Card, simply press the eject button next to the slot.

Conserving Battery Power

To conserve battery power remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).

Figure 2 - 5
PC Card Slot
Using The Computer

Hot-Keys

The four Hot-Key buttons include Tab & Esc keys (these keys are particularly useful in Tablet Mode) and a wheel key for scrolling/Enter key functionality. (Move the wheel left or right for scrolling functions in much the same way as the keyboard arrow keys; push the wheel in for Enter/Return functions.) In Tablet Mode the “Q” key is used to toggle the screen rotation between Landscape and Portrait configurations; it also acts as a power button. The table below lists the function options depending upon the time duration the key is pressed (see sidebar for use in Notebook mode).

<table>
<thead>
<tr>
<th>Power State</th>
<th>“Q” key function</th>
<th>Time Pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Rotate Screen</td>
<td>Tap (do not press) Less than 0.8 seconds</td>
</tr>
<tr>
<td></td>
<td>Initiates the default setting of OS’s power scheme (Power Button) - “When I press the power button on my portable computer” - (see Figure 3 - 10 on page 3 - 13)</td>
<td>More than 0.8 seconds but less than 4 seconds</td>
</tr>
<tr>
<td>On</td>
<td>System Shutdown</td>
<td>More than 4 seconds</td>
</tr>
<tr>
<td>Off</td>
<td>System Power On</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 2 - 4
Q Key Functions

Right Cover Sensor
The right LCD cover sensor (see “Cover Sensors” on page 1 - 10) is used in conjunction with the “Q” Hot-Key to tell the computer when it is in Tablet mode (when the computer is in Tablet mode the right cover sensor is depressed).

If you are in Notebook mode you can perform the same set of functions listed in the table by tapping/pressing the “Q” key and right cover sensor simultaneously.

2 - 16 Hot-Keys
The Keyboard

The Function Keys

On the bottom-left of the keyboard is the \textbf{Fn} key, or Function key, which allows you to change operational features instantly. To use the functions press and hold the \textbf{Fn} key, then press the appropriate function key (F3 - F11 etc.) located on your keyboard.

<table>
<thead>
<tr>
<th>Function Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep/Resume Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
</tr>
<tr>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>Wireless LAN Module On/Off Toggle</td>
</tr>
</tbody>
</table>

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However, special functions/hot keys unique to the system’s regular keyboard may not work.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module is \textbf{OFF} if you are using the computer aboard aircraft. When your computer ‘Boots Up’ the module will be \textbf{ON}. To toggle power to the WLAN module use the key combination \textbf{Fn} + \textbf{F11}.

\textbf{Table 2 - 5} Function Keys
Using The Computer

2 - 18 The Keyboard

Numeric Keypad

The keyboard has an embedded numerical keypad for easy numeric data input. Activate the **Number Lock** feature by pressing the **Fn** and **Num Lk** key combination. You may check if **Number Lock** is enabled or not by looking at the LED status indicators (see “LED Indicators” on page 2 - 5). To type a number from the numeric keypad make sure **Num Lk** is enabled, then press the key on the numeric keypad. (To type a letter from the numeric keypad if **Num Lk** is enabled, hold down the **Fn** key and press the appropriate letter key.)

Activate **Scroll Lock** by pressing the **Fn** and **Scr Lk** key combination.

Special Characters

Some software applications allow the number-keys to be used with **Alt** to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that **Num Lock** is on.

Figure 2 - 6

Keyboard
If your computer is Model A the screen also acts as a Touch Panel when the driver is installed (see “Touch Panel (Model A Computers)” on page 4 - 9). You can use a stylus pen (you can also use your finger or any soft-tipped object as the input device) to point directly to objects on the screen in much the same way as you would use your mouse as the pointing device.

A new icon ( or ) will appear in the taskbar (if you do not see the icon go to the Touch Panel control panel and click the tickbox to display the icon in the taskbar - see Figure 2 - 8) after you install the Touch Panel driver. Click this icon to switch your provided stylus pen to act as a left or right mouse button. The Touch Panel control panel allows you to configure the input options from the Touch Panel Set-Up and Configuration Utility (see over for screen examples). Make sure you calibrate the Touch Panel.

Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device.

Pay particular attention to the area at the edge of the screen where the LCD meets the frame (see page 2 - 21).
Using The Computer

2 - 20 Touch Panel (Model A Only)

**Touch Panel Calibration**

Make sure you calibrate the Touch Panel from the Touch Panel Set-Up and Configuration Utility.

1. Click the **Calibration** tab.
2. Click the **Calibrate Now** button.
3. Use the input device to touch the cross at the different positions on screen.
4. Click the **Update** button.

*Figure 2 - 8 Touch Panel Set-Up and Configuration Utility*
Be very careful not to press too hard with the stylus pen when using it as the input device. Use only the approved stylus pen provided. When writing on the screen, avoid sliding the stylus pen (or any object) in the area around the edge of the screen (between the LCD and the frame).

Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device.

Do Not Slide the Stylus Pen (or any object) Around the Edge of the LCD Screen
**TouchPad and Buttons/Mouse**

The TouchPad is a device for pointing (controlling input positioning) on the computer’s display screen by sensing finger movement, and downward pressure. It is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports.

The TouchPad buttons function in much the same way as a two-button mouse (see *Figure 2 - 10 on page 2-23* for screen examples).

---

**Mouse Driver**

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device's user documentation for details.
Configuring the TouchPad and Buttons

Once you have installed the TouchPad drivers (see “What to Install” on page 4 - 2) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information on this at www.synaptics.com.

Figure 2 - 10
Mouse Properties
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use either of the USB ports on your computer to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer
This is still the most common type of printer. A Parallel to USB converter may be purchased at most computer stores. The install instructions are in the sidebar.
Chapter 3: Advanced Controls

Overview

This chapter covers:

• Advanced Video Controls
• Power and Battery Management Features
• PC Camera Module (optional)
• Wireless LAN Module (optional)

Note: All operating system pictures in this manual are from the Microsoft Windows XP OS.

Drivers

You are unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn't been properly configured (your service representative may have already done that for you), refer to “What to Install” on page 4-2 for installation instructions.
Advanced Video Controls

This section is about making adjustments for the LCD, and switching display devices.

Opening the LCD
As you open the lid, adjust it so you can look at the screen straight on, without any glare. If necessary, adjust the brightness controls (Fn + F8/F9). The Fn + F7 key combination allows you to toggle through display options if you have a monitor attached ("Function Key Combination" on page 3 - 7).

Protecting the LCD
Do not allow any foreign objects (i.e. paper or plastic) to get between the lid/LCD and the work panel. They could damage or scratch the LCD and/or accidentally activate the close cover switch.

Figure 3 - 1
Display Controls
Video Driver Controls

The video interface lets you change the screen resolution and color output to whatever is most comfortable/efficient for you. This is a matter of hardware, video memory and the driver for your operating system. The driver interface shows the available options (see A - 1 & B - 1 for the LCD options).

You can switch display devices from the Display Properties control panel in Windows as long as the video driver is installed (see “What to Install” on page 4 - 2).

Making Adjustments for the Display

The higher the resolution you set the LCD for, the more information the LCD can display on screen. To change the LCD’s resolution and color depth go to the Display Properties control panel:

1. Click Start, point to Settings (or just click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
2. Double-click Display (icon).
3. In the Display Properties dialog box, click Settings (tab).
4. In Screen resolution, move the slider to the preferred setting for resolution (see 1 in Figure 3 - 2 on page 3-4).
5. In Color quality, click the arrow and scroll to the preferred setting for color depth (see 2 in Figure 3 - 2 on page 3-4).

Screen Resolution/Screen Area Note

You may set the resolution to a higher setting than the panel supports, however this will require you to pan (scroll) around the screen as the display area will be larger than what you can see on the LCD.
When the **Display Properties** control panel is open, click the **Advanced** (button) to bring up the options tabs. Clicking through these tabs allows you to make any video adjustments you require.
S3 Control Taskbar Utility

With the video driver installed the S3 Control Utility will appear in the taskbar. Click the icon $\square$ to bring up the menu below. From this menu you can enable/disable displays, and configure the rotation of the display.

S3 Advanced Display Properties

With the video driver installed additional tabs are available in the Advanced Display Properties 3 (Figure 3 - 2 on page 3-4). Click Advanced in the Display Properties Control Panel (see “Making Adjustments for the Display” on page 3 - 3) to see the additional tabs.

If you are playing a DVD/VCD video in Windows Media Player, do not rotate the screen while playing the video. If you wish to rotate the screen, quit the Media Player program first, rotate the screen, then open the player to play the video.
The S3 tabs allow you to adjust the displays and video settings (note some options will only appear when you have attached an external monitor/LCD). Screen examples are shown below.

Help Menus
Right-click on any item in the S3 tabs to bring up the “What’s This?” button.
Click the button to bring up the help menu.
Display Devices

Besides the built-in LCD, you can also use an external VGA monitor (CRT) as your display device. A VGA monitor connects to the external monitor (CRT) port (Figure 3 - 6).

To use an external display:

1. Attach the VGA monitor (CRT) to the external monitor port.
2. Click the icon in the taskbar to bring up the menu to select the CRT (it should have a tick alongside it) and allow the monitor time to refresh the display.

OR

1. Attach the VGA monitor (CRT) to the external monitor port.
2. Click Advanced in the Display Properties Control Panel (see “Making Adjustments for the Display” on page 3 - 3) to see the additional tabs.
3. Select the S3 Display tab.
4. Click to put a tick in the tickbox under the CRT icon.
5. Click Apply > OK and allow the monitor time to refresh the display.
6. Click Yes to confirm the settings.
Power Management Features

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in *Windows XP*.
Enabling Power Options

Power Options are enabled through the control panel in your Windows system (Power Options). With other operating systems you may have power management available, so check your documentation.

You may conserve power through individual components or throughout the whole system.
Power Schemes

You can set your computer to conserve power through individual components by means of Power Schemes. Each scheme will also adjust the processor performance of your machine in order to save power (see sidebar). The settings for each scheme can be adjusted to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). You can also set a specified time for the system to enter Standby or Hibernate modes (see “Conserving Power (System)” on page 3 - 11).

Power Schemes & CPU Performance

Windows Power Schemes also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under battery power). The “Always On” setting will give the highest performance, and the “Max Battery” setting will give the highest power savings.

Figure 3 - 8
Power Schemes

Resuming Operation

The system can resume from Monitor or Hard Disk Standby by pressing a key on the keyboard.
Conserving Power (System)

With this function you can stop the computer’s operation and restart where you left off. This system features Standby and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - Figure 3 - 9 on page 3-12).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on standby instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Standby mode.
Standby

Standby saves the least amount of power, but takes the shortest time to return to full operation. During Standby the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Standby mode to save power.

Hibernate

Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

Figure 3 - 9

Enable Hibernation
Configuring the Power Button

The power button may be set to send the computer into either Standby or Hibernate mode. In Standby mode, the LED ( mogul ) will flash green. In Hibernate mode the LED will be Off (battery powered)/Orange (AC Adapter powered). If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

It is recommended that you set the lid (left LCD cover sensor) power button to “Do nothing”. This will prevent accidentally triggering a power saving mode when you rotate the LCD swivel screen.

You may also configure the Sleep/Resume key combination (Fn + F4) from the menu illustrated in Figure 3 - 10. In Windows this is referred to as the Sleep button.
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery before using it (see “Battery FAQ” on page 3 - 15 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Caution
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

Figure 3 - 11
Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6-3.

**Battery FAQ**

**How do I completely discharge the battery?**
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the **Power Options** functions in the **Control Panel**, especially any **Alarms** (uncheck the tickboxes - see page 3-14) and **Schemes** (change all the settings to **Never** - see page 3-10). As the battery nears the end of its life save and close any critical files.

**How do I fully charge the battery?**
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

**How do I maintain the battery?**
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

---

**Conserving Battery Power**

To conserve battery power:

- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC adapter.
- Close modem or communication applications when they are not being used.
- Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).
- Disconnect any unnecessary external devices.
After installing the driver (see “VIA Power Saver” on page 4 - 10) you will have the VIA Power Saver 2.0 utility available to you. You can click the short-cut on the desktop or the program icon (Startup > Programs/All Programs > VIA > Power Saver) to bring up the utility. The VIA Power Saver utility will give you information on power consumption and management. You can configure the settings for best power management when powered by battery (DC IN) or by the AC adapter (AC IN).
PC Camera

If you have purchased the optional PC Camera you will need to install the device driver for it as indicated in “PC Camera” on page 4 - 8.

After installing the driver you can run the application software by going to the Camtel USB PC Camera item in the Start > Programs/All Programs menu and selecting the AMCAP program.

PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Category View > Speech, and Audio Devices).
2. Click Advanced in the Volume tab.
3. Click Options (Volume Control) and scroll down and click Properties.
4. Click Recording (Adjust volume for) and click Microphone (check box), then click OK.
5. Make sure the Select (check box) in the Recording Control panel, under the Microphone section, is checked (boost the volume as high as it will go).
6. Close the open windows.
Advanced Controls

Figure 3 - 13
Audio Setup
AMCAP

AMCAP is a video viewer useful for general purpose video viewing and testing, and capturing video files to .avi format.

1. Run the AMCAP program from the Start > Programs/All Programs > Camtel USB PC Camera menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio make sure that the Capture Audio option is ticked) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file. Click Start Capture again.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, then click Open (you can view the file using the Windows Media Player).

Set Capture File

In AMCAP program you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space

You may pre-allocate the file size for the capture file in the AMCAP program. You can choose to ignore this by clicking Cancel.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Wireless LAN Module

If you have purchased the optional IEEE 802.11b Wireless LAN USB module make sure you install the driver for it (see “Wireless LAN” on page 4 - 8). A status icon will appear in the taskbar, and a shortcut to the IEEE 802.11b WLAN utility will appear on the desktop. Double-click the desktop icon to configure the settings for your WLAN module.

Make sure the module is powered on before installing the driver. To toggle power to the WLAN module use the key combination Fn + F11.

Full instructions for use of the Wireless LAN module are available in the manual installed with the driver. The User Manual is in Adobe .pdf format (Start menu and point to Programs/All Programs > IEEE 802.11b WLAN Utility (USB) then select the User Manual).

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module is OFF (the LED is off) if you are using the computer aboard aircraft. When your computer ‘Boots Up’ the module will be ON. To toggle power to the WLAN module use the key combination Fn + F11.
Chapter 4: Drivers & Utilities

Overview

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities. In this chapter, we group driver and utility installation instructions by operating system. The following operating systems are covered.

- *Windows XP Professional & Home Editions*
What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM contains the drivers and utilities necessary for the proper operation of the computer. Table 4 - 1 on page 4 - 5 lists what you need to install manually according to your choice of the operating system. It is very important that the drivers are installed in the order indicated in the table.

New Hardware Found

If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure as directed.

Navigate (Browse..) to D:

You will notice that many of the instructions for driver installation require you to “Navigate (Browse) to D:”. In this case “D:” is the drive specified for your CD device. Not all computers are setup the same way, and some computers have the CD listed under a different drive letter - e.g. if you have two hard drives (or hard disk partitions) one may be designated as “Drive C:” and the other as “Drive D:”. In this case the CD device may be designated as “Drive E:” - Please make sure you are actually navigating to the correct drive letter for the CD device.

When you click the Browse (button) after clicking Run in the Start menu you will see the “Look in:” dialog box at the top of the Browse window. Click the scroll button to navigate to My Computer to display the devices and drive letters.
Authorized Driver Message
If you receive a message telling you that the driver you are installing is not authorized (Digital Signature Not Found), just click Yes or Continue Anyway to ignore the message and continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file version conflict” message, please click Yes to choose to keep the existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel. Double-click System (icon) and then click Hardware (tab) > Device Manager (button).
2. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
3. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.
Drivers & Utilities

Driver Installation

You have a choice of installation methods to install your drivers.

Automatic Driver Installation
Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the Drivers Installer application will run automatically.

1. Check the driver installation order from the table Table 4 - 1 on page 4 - 5 (the drivers must be installed in this order).
2. Double-click the driver you wish to install (do not press any keys).
3. Follow the installation procedure as listed in the manual installation process (the automatic installation procedure eliminates the need to navigate to the setup executable file).

Manual Driver Installation
Insert the Device Drivers & Utilities + User’s Manual CD-ROM and close the Drivers Installer application. Follow the procedures listed in this chapter.

Note: The Touch Panel driver must be installed manually.
<table>
<thead>
<tr>
<th>Driver</th>
<th>Windows XP Home/ Professional Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIA 4 in 1</td>
<td>page 4 - 6</td>
</tr>
<tr>
<td>VIA VGA (Video)</td>
<td>page 4 - 6</td>
</tr>
<tr>
<td>VIA LAN</td>
<td>page 4 - 7</td>
</tr>
<tr>
<td>Modem</td>
<td>page 4 - 7</td>
</tr>
<tr>
<td>PCMCIA/PC Card</td>
<td>page 4 - 7</td>
</tr>
<tr>
<td>PC Camera</td>
<td>page 4 - 8</td>
</tr>
<tr>
<td>Wireless LAN</td>
<td>page 4 - 8</td>
</tr>
<tr>
<td>Touch Panel (Manual Install Only for <strong>Model A computers only</strong>)</td>
<td>page 4 - 9</td>
</tr>
<tr>
<td>Infrared (VIA FIR)</td>
<td>page 4 - 9</td>
</tr>
<tr>
<td>TouchPad</td>
<td>page 4 - 10</td>
</tr>
<tr>
<td>VIA USB 2.0</td>
<td>page 4 - 10</td>
</tr>
<tr>
<td>VIA Power Saver</td>
<td>page 4 - 10</td>
</tr>
<tr>
<td>VIA Audio</td>
<td>page 4 - 10</td>
</tr>
</tbody>
</table>

*Table 4 - 1 - Install Procedure*
**Windows XP**

This section covers driver and utility installation instructions for the *Windows XP OS*.

1. Click **Start (menu) > Run...**
2. Navigate (**Browse..**) to `D:\Drivers\4 in 1\VIAHyperion4in1447v.exe` and click **OK**.
3. Click **Next > Yes > Next > Next > Next > Next**.
4. Click **OK** to restart the computer.

**VIA 4 in 1**

1. Click **Start (menu) > Run...**
2. Navigate (**Browse..**) to `D:\Drivers\4 in 1\VIAHyperion4in1447v.exe` and click **OK**.
3. Click **Next > Yes > Next > Next > Next > Next**.
4. Click **OK** to restart the computer.

**VIA VGA (Video)**

1. Click **Start (menu) > Run...**
2. Navigate (**Browse..**) to `D:\Drivers\VGA\SETUP.EXE` and click **OK**.
3. Click **Next > Next > (click Continue Anyway if asked if you want to continue)**.
4. Click **Finish** to restart the computer.

---

**Windows XP Service Pack 1**

Make sure that you install *Windows XP Service Pack 1/1a* before installing all the drivers for Windows XP.
VIA LAN
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\LAN\setup.exe and click OK > OK.
3. The network settings can now be configured.

Modem
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Modem\Setup.exe and click OK.
3. Click (button).
4. Click .
5. The modem is ready for dial-up configuration.

PC Card/PCMCIA
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\PCMCIA\Setup.exe and click OK.
3. Click Next > Next.
4. Click Finish to restart the computer.

Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
Drivers & Utilities

PC Camera
1. Click Start (menu) > Run...
2. Navigate (Browse...) to
   D:\Drivers\PCCam\SETUP.exe and click
   OK.
3. Click Next.
4. Click Finish to restart the computer.
5. To run the application software go to the PC
   Camera 301P USB Camera item in the Start
   > Programs/All Programs menu, and select
   the AMCAP program.

Wireless LAN
Make sure the module is powered on before install-

1. Click Start (menu) > Run...
2. Navigate (Browse..) to
   D:\Drivers\WLAN\Setup.exe and click OK.
3. Click Next > Next > Yes > Next > Next.
4. Click Yes if you wish to add a shortcut to the
   WLAN utility on the desktop.
5. Follow the instructions (Next > Next > OK) to
   install the Adobe Acrobat Reader (if you do
   not already have Adobe Acrobat Reader
   installed) and click Continue Anyway if asked
   if you want to continue.
6. Click Finish and restart the computer.

The Wireless LAN User Manual is in Adobe .pdf
format (Start menu and point to Programs/All
Programs > IEEE 802.11b WLAN Utility (USB)
then select the User Manual).
Touch Panel (Model A Computers)

1. If you can see the My Computer icon on your desktop (if you cannot see the My Computer icon go to step 2) click on it once to select it, then right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).

2. If you cannot see the My Computer icon click Start (menu), then point to (but don’t click just highlight it) My Computer. Right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).

3. Click the Hardware (tab), then click Device Manager (button).

4. Click “+” next to Mice and other pointing devices (if its sub-items are not shown).

5. Double-click Microsoft Serial Mouse and click Driver (tab).

6. Click Update Driver (button).

7. When the Hardware Update Wizard appears, click “Install from a list or specific location (Advanced)” then click Next.

8. Select “Don’t search. I will choose the driver to install.” and click Next.

9. Click Have Disk (button) and navigate (Browse...) to D:\Drivers\Touch Panel and click Open > OK > Next (click Yes and/or Continue Anyway if asked if you want to continue).

10. Click Finish and close the open windows.


Infrared (VIA FIR)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Drivers\FIR\Setup.exe and click OK.

3. Click Next > Next.

4. Click Finish and restart the computer.
Drivers & Utilities

**TouchPad**

1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse...**) to `D:\Drivers\TouchPad\Setup.exe` and click **OK**.
3. To continue click **Next > Next > Next** (click **Continue Anyway** if asked if you want to continue).
4. Click **Finish** to restart the computer.
5. You may then configure your TouchPad as outlined in **“Configuring the TouchPad and Buttons” on page 2 - 23.**

**VIA USB 2.0**

1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse...**) to `D:\Drivers\USB\Setup.exe` and click **OK**.
3. To continue click **Next > Yes > Next**.
4. Click **Finish** to restart the computer.
5. See **“Via Power Saver 2.0” on page 3 - 16.**

**VIA Power Saver**

1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse...**) to `D:\Drivers\PowerSaver 2.0\Setup.exe` and click **OK**.
3. To continue click **Next > Yes > Next**.
4. Click **Finish** to restart the computer.
5. See **“Via Power Saver 2.0” on page 3 - 16.**

**VIA Audio**

1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse...**) to `D:\Drivers\Audio\Setup.exe` and click **OK** > **Next > Next**.
3. Click **Finish** to restart the computer.
4. Click the **Speaker** icon in the taskbar for configuration options.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** the POST (Power-On Self Test)

**Configuration:** the Setup & FirstWare utilities

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
Important BIOS Settings

Generally speaking you should not have to adjust any of the BIOS settings as they will already be set for your computer. However the following is a quick reference to the most important settings you may need to change at some point.

<table>
<thead>
<tr>
<th>Option</th>
<th>Page #</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Menu</td>
<td>5 - 18</td>
<td>Specifies the order of the devices on which the computer searches for an operating system as it starts up.</td>
</tr>
</tbody>
</table>
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the RAM. **However you will only see the POST screen as illustrated in Figure 5 - 1 if you have “Enabled” the Boot-Time Diagnostic option** (see “Boot-time Diagnostic Screen: (Advanced Menu)” on page 5 - 11).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem which prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen & Phoenix Firstware

Note that you may not see the POST screen as illustrated in Figure 5 - 1, if the Boot-Time Diagnostic option is disabled.

If you have enabled the Boot-Time Diagnostic option then the Phoenix FirstWare Utilities menu will not appear.

At any time during the boot process you can press the F2 key to enter the Setup configuration utility.
FirstWare Utilities

The FirstWare utilities screen will appear as the computer boots up (you will see the Logo screen as long as the Boot-Time Diagnostic is Disabled - see “POST Screen & Phoenix Firstware” on page 5 - 3). The message “Click mouse or press <Enter> for System Utilities” will appear at the bottom of the screen. Pressing the Enter key or clicking the mouse will bring up the options.

To enter the Setup utilities scroll, select and click “Launch System Setup”. You may also access the Setup utilities by pressing the F2 key at any time during the boot process. The FirstWare utilities also allow you to select a boot device, set password options, and get information on the system.
POST Screen

PhoenixBIOS 4.0 Release 6.0 1
Copyright 1985-2002 Phoenix Technologies Ltd.
All Rights Reserved

VIA VLINK (CLE2666 + VT8235)
BIOS Version 1.00.P2
KBC Version 1.00.P1
CPU = VIA C3 processor 1.00 GHz 2
639K System RAM Passed
221K Extended RAM Passed
System BIOS shadowed
Video BIOS shadowed
Fixed Disk 0: IC2GN020ATCS04-0 4

Press <F2> to enter SETUP 5

Figure 5 - 1
POST (Sample) Screen

1. BIOS information
2. CPU type
3. Memory status
4. HDD identification notice
5. Enter Setup prompt appears only during POST
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume,
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.
Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST or Logo startup screen (alternatively you can press Enter or click the mouse when you see the Logo startup screen - see “POST Screen & Phoenix Firstware” on page 5 - 3).

The prompt (“Press F2 to Enter Setup”) seen in Figure 5 - 1 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error” (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 (or Enter when you see the Logo startup screen) when prompted. Setup’s main menu will appear.

Setup Screens
The following pages contain additional advice on portions of the Setup. Along the top of the screen is a menu bar with six (6) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.
### System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.

---

**Figure 5 - 2 Main Menu**

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Security</th>
<th>Power</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Time</td>
<td>[22:01:05]</td>
<td>System Date</td>
<td>[07/07/2003]</td>
<td>Item Specific Help</td>
<td></td>
</tr>
<tr>
<td>Primary Master</td>
<td>[IC25N020ATCS04-0-{PM}]</td>
<td>QuickBoot Mode:</td>
<td>[Enabled]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary screen:</td>
<td>[Enabled]</td>
<td>System Memory:</td>
<td>640 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extended Memory</td>
<td>226304 KB</td>
<td>System Memory:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**F1** Help  **F9** Setup Defaults

**Esc** Exit  **F10** Save and Exit

---

**5 - 8 Main Menu**
Primary Master (Main Menu)
This item gives information on the main IDE HDD which fits into the computer’s HDD bay.

QuickBoot Mode: (Main Menu)
Enable the QuickBoot Mode to skip certain tests while the computer boots up. This will decrease the time needed to boot the system.

Summary screen: (Main Menu)
Enable this option to display the system configuration as the computer boots up.
Figure 5 - 3
Advanced Menu

PhoenixBIOS Setup Utility

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Security</th>
<th>Power</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
</table>

- **Setup Warning**
  Setting items on this menu to incorrect values may cause your system to malfunction.

- **FirstWare Language:** [English]
- **Firstware Authentication Level:** [High]
- **Firstware Video Mode:** [1024x768]
- **Boot-time Diagnostic Screen:** [Disabled]
- **Advanced Chipset Control**
- **I/O Device Configuration**

- **Legacy USB Support:** [Enabled]
- **Large Disk Access Mode:** [DOS]
- **Installed O/S:** [WinXP]
- **Reset Configuration Data:** [No]

**F1** Help  
**F2** Select Item  
**F9** Change Values  
**F10** Setup Defaults

**Esc** Exit  
**Enter** Select Menu

Sets the current FirstWare language to the selected language.

5 - 10 Advanced Menu
**Firstware Language: (Advanced Menu)**
Set the display language for the Firstware utilities which load at startup.

**Firstware Authentication Level: (Advanced Menu)**
Set the authentication level for the Firstware utilities to “Low”, “Medium” or “High”.

**Firstware Video Mode: (Advanced Menu)**
Set the screen resolution for the Firstware utilities (setting the resolution too high may cause some information not to be displayed on screen).

**Boot-time Diagnostic Screen: (Advanced Menu)**
Enable this item to display the POST screen as illustrated in *Figure 5 - 1*. If this item is enabled then the Phoenix Firstware utilities will not be displayed.
Advanced Chipset Control: (Advanced Menu)
Items under this menu are best left to the defaults unless if you are an advanced user:

- **PCI Delay Transaction** - Choose “Enabled” for more efficient use of the PCI Bus and to meet PCI 2.1 specifications. Only disable if your PCI Cards are not PCI 2.1 compliant, or if the PCI Cards are not working properly with the feature enabled.

- **Aperture Size** - The AGP aperture is an area of system RAM reserved for use by the AGP card for storing textures if it needs to. The RAM is available for use by the system as normal if not used by the graphics card. It is recommended that the setting is set to either the default “64M”, or “128M” or “256M”.

- **Frame Buffer Size** - You can increase the size of the frame buffer to get a better 3D performance (e.g. if you are playing games). This memory is allocated from the system memory.

I/O Device Configuration: (Advanced Menu)
Configure the options for the Infrared and COM ports here.
Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not normally support USB functionality (e.g. DOS). The default setting is “Enabled” and does not need to be changed if you intend to use your USB devices in Windows.

Large Disk Access Mode: (Advanced Menu)
Select “Other” if you are using systems such as Novell, UNIX etc. Select “DOS” (default) if you are using Windows.

Installed O/S: (Advanced Menu)
This setting tells the computer what kind of operating system you’re using.

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.
Security Menu

The changes you make here affect the access to the Setup utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.
Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a “Password on Boot” (see below). You can set the user password from the submenu (Set User Password) after you have set the supervisor password.

Set User Password (Security Menu)
You can set a password for user mode access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a “Password on Boot” (see below). Many menu items in the Setup utility cannot be modified in user mode. You can only set the user password after you have set the supervisor password.

Fixed disk boot sector: (Security Menu)
Choose Write Protect to protect the area of the hard disk containing information on how to start up the computer from having information written to it. This helps prevent viruses from affecting this area, however, it is not a substitute for proper virus protection supplied by updated anti-virus software. This is merely an extra safeguard (see “Viruses” on page 7 - 4).

Virus check/System backup reminder: (Security Menu)
Choose a time frame to receive a reminder message for running a virus check and/or system backup if you wish.
Password on boot: (Security Menu)

Specify whether a password (supervisor or user password) should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see “Warning” in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter. Type the existing password and press Enter. Then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.
Power Menu

PC Beep: (Power Menu)
Choose "Enabled" to receive a system beep if the power has reached a critically low state.

**Turbo/DeTurbo (Power Menu)**
This option is best left to the default "Disabled" setting for system stability. If you need to adjust the CPU clock for any reason, the settings are as follows:

- **Enabled** = CPU Clock at 1003MHz
- **Disabled** = CPU Clock at 999MHz

![Power Menu Diagram](image)
Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows XP) from the devices listed in this menu, and in this order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot Menu. Boot devices usually are hard drives, floppy drives (removable devices), CD-ROMs and networks (LANs).
When you specify a device as a boot device on the Boot Menu, it requires the availability of an operating system on that device. Most PCs come with an operating system already installed on hard drive “C:”.

If you wish to boot from a CD-ROM you will need to add it to the boot order. As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM Drive
3. Hard Drive
4. Networks (LANs)

In everyday use you will usually boot from the hard drive, however there may be occasions when it is advantageous to boot from a floppy disk or CD-ROM.

**Phoenix FirstWare Utilities**

You can also use the Phoenix FirstWare utilities to select a boot device (see “POST Screen & Phoenix Firstware” on page 5 - 3 and “FirstWare Utilities” on page 5 - 4).
Choosing to **“Discard Changes”** or **“Exit Discarding Changes”** will wipe out any changes you have made to the Setup. You can also choose to restore the original Setup Defaults which will return the Setup to its original state and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

• Replacing the Battery
• Replacing the HDD
• Upgrading the System Memory
• Replacing the CD Device

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should not perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

Battery Removal Process
1. Turn the computer off, and turn it over.
2. Locate the battery bay as highlighted in Figure 6 - 1.
3. Slide the battery lock in the direction of the arrow 1.
4. Slide the battery lock in the direction of the arrow 2, and hold it in place.
5. Slide the battery in the direction of the arrow 3, then lift it up and out of the computer's battery bay.

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5” IDE hard disk drives. Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “What to Install” on page 4 - 2), when setting up a new hard disk.

Hard Disk Upgrade Process
1. Turn off the computer, and turn it over and remove the battery.
2. Remove screw 1 from the hard disk cover.
3. Slide the hard disk in the direction of the arrow 2, and lift it out of the computer.

Figure 6 - 2
HDD Removal

HDD System Warning
New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) - DDR 266 MHz - type memory modules. The main memory can be expanded up to 1024MB. The SO-DIMMs supported are 256MB, and 512MB in size, and the total memory size is automatically detected by the POST routine once you turn on your computer.

Memory Upgrade Process

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws 1 - 4 from the memory socket cover 5, and remove the cover.

Figure 6 - 3
Memory Socket Cover Removal
Upgrading The Computer

3. Gently pull the two release latches on the sides of the memory socket in the direction of the arrows (1 & 2 in Figure 6 - 4).

4. The module 3 will pop-up, and you can remove it.

5. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.

6. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.

7. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.

8. Replace the memory socket cover and the 4 screws (see Figure 6 - 3).

9. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

Figure 6 - 4
Removing/Installing a RAM Module

6 - 6 Upgrading the System Memory (RAM)
Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. The processor is surface mounted and is not a user serviceable part (see sidebar).

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
Upgrading The Computer
Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the **LED Power Indicators** (see “LED Power Indicators” on page 2 - 5) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Standby mode by pressing the keys configured in your Power Management/Power Options (see “Conserving Power (System)” on page 3 - 11), or by pressing the Fn + F4 key combination, to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see “Advanced Video Controls” on page 3 - 2).

- **Display Choice** - Press Fn + F7 to make sure the system is not set to only a CRT display (see “Function Key Combination” on page 3 - 7).

- **Boot Drive** - Make sure there are no floppy disks in any floppy drive attached when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.

- Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a Startup password for the SCU (see “Security Menu” on page 5 - 14).

- Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Viruses

- Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

- Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Troubleshooting

Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

- Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Power

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the power but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery LED indicator is blinking orange and/or a beeping sound is heard.</td>
<td><em>Low Battery.</em> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing battery power too quickly.</td>
<td><em>The system is using too much power.</em> If your OS has a Power Options scheme (see “Power Schemes” on page 3 - 10) check its settings. You may also be using a PC Card device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual battery operating time is shorter than expected.              | *The battery has not been fully discharged before being recharged.* Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 14).  
*Power Options have been disabled.* Go to the Control Panel in Windows and re-enable the options.  
*A peripheral device or PC Card is consuming a lot of power.* Turn off the unused device to save power.                                                                                       |
Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are blocked (see “Overheating” on page 1-16). If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface. Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Display

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
</table>
| Nothing appears on screen. | The system is in a power saving mode. Toggle the sleep/resume key combination, **Fn + F4** (see “The Keyboard” on page 2 - 17).  
The computer is set for a different display. Toggle the screen display key combination, **Fn + F7**. If an external monitor is connected, turn it on.  
The screen saver is activated. Press any key or touch the **TouchPad**. |
| No image appears on the external monitor I have plugged in and powered on. | You haven’t installed the video driver and configured it appropriately from the **Control Panel**. See “VIA VGA (Video)” on page 4 - 6 for instructions on installing the driver, and see “Video Driver Controls” on page 3 - 3 for instructions on configuring the video driver.  
You haven’t used the key combination to switch the display options. Press the **Fn + F7** key combination to toggle through the options. |

---

### Windows Media Player and Screen Rotation

If you are playing a DVD/VCD video in Windows Media Player, **do not rotate the screen while playing the video**. If you wish to rotate the screen, quit the Media Player program first, rotate the screen, then open the player to play the video.
### Troubleshooting

**Boot Password**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the boot password.</td>
<td><strong>If you forget the password, you may have to discharge the battery of the CMOS.</strong> Contact your service representative for help.</td>
</tr>
</tbody>
</table>

---

**Password Warning**

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
### Audio

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low.</em> Check the volume control in the <a href="#">Volume Control Panel</a> in the Windows taskbar, or use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> (see “The Function Keys” on page 2 - 17) to adjust.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## CD Device (Optional)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The compact disc cannot be read.</td>
<td><em>The compact disc is dirty.</em> Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray.</em> Gently try to remove the disc using the eject hole (see “Loading CDs or DVDs” on page 2 - 10).</td>
</tr>
<tr>
<td>The system cannot read from the optional CD/DVD device.</td>
<td><em>The system cannot not read from the optional USB 2.0 CD/DVD device.</em> When used with your computer the optional USB 2.0 CD/DVD device must be powered by an AC power source via the AC adapter. When used with the AC adapter make sure the power switch is set to EXT (external power).</td>
</tr>
<tr>
<td>The regional codes can no longer be changed.</td>
<td>The regional codes have already changed the maximum 5 times - See “DVD Regional Codes” on page 2 - 12.</td>
</tr>
</tbody>
</table>

**Media Warning**

When manually ejecting a CD/DVD, DO NOT use a sharpened pencil or similar object which may break, and become lodged in the hole.
Keyboard

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td>If the LED is lit, then Num Lock is turned ON. Press and release the Fn and Num Lk key combination (see “Numeric Keypad” on page 2 - 18).</td>
</tr>
</tbody>
</table>

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.
## Troubleshooting

### Operation

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td>The system’s power saving features have timed-out. Use the AC adapter, press the sleep (<a href="#">Fn + Esc</a>) key combination, or press the power button if no LEDs are lit. A software conflict made the system “crash”. Consult your OS manual. As a last resort, since you will lose any unsaved data, try to reboot the system or if that doesn’t work, turn the computer off and on again.</td>
</tr>
<tr>
<td>The system never goes into Hibernate mode.</td>
<td>Make sure you have enabled Hibernate in the Power Options control panel in your OS (see “Hibernate” on page 3 - 12).</td>
</tr>
<tr>
<td>The system does not go into a power saving mode when the battery is low.</td>
<td>No power saving options are enabled. Use one of the Power Options presets.</td>
</tr>
<tr>
<td>The system turns goes into a power saving mode when rotating the swivel screen.</td>
<td>The swivel screen has accidentally hit the left LCD cover sensor, and triggered a power saving mode, when rotating the LCD swivel screen. It is recommended that you set the lid (left LCD cover sensor) power button to “Do nothing”.</td>
</tr>
<tr>
<td>Why does my computer CPU speed show as 999MHz in the General tab of the System Properties control panel?</td>
<td>This is because the calculation method used by the Windows OS eliminates all decimal points. The actual CPU speed is 999.75MHz.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Why does the Winbench 99 program show a “StartMgr” message error while running “disable all startup program”?</td>
<td><em>This is due to the Touch Panel driver.</em> The Touch Panel driver will copy a file into the Startup programs group and this file cannot be deleted by the system or any utility. This will not influence the test result, and serves only as a reminder.</td>
</tr>
</tbody>
</table>
Appendix A. Model A Specifications

Processor Options
• VIA Antaur 1.0 GHz

Memory
• Two 200-pin SODIMM Sockets, Supporting 266 MHz DDR Modules
• Memory Expandable up to 1GB (256/ 512 MB DDR Modules)

Core Logic
• CLE266CE

Structure
• ACPI v1.0b Compliant

Security
• Security (Kensington® Type) Lock Slot
• BIOS Password

BIOS
• ACPI 4MB Flash ROM

LCD
• 14.1” XGA (1024*768) Flat Panel TFT with Built-In Touch Panel and Stylus Pen
• LCD Swivel Hinge feature allows conversion between Notebook and Tablet Modes
**Storage**
- Easy Changeable 2.5” 9.5 mm (h) 20GB HDD ATA-33/66/100
- External FDD with USB (**optional**)
- External CD-ROM/ CD-RW/ DVD-ROM/ Combo Drive (**optional**)
- Built-in 4-in-1 Card Reader for the following formats:
  - SD (Secure Digital)
  - MMC (Multi Media Card)
  - MS (Memory Stick)
  - SM (Smart Media Card)
- PC Card
  - One Type-II PCMCIA 3.3V/5V Socket

**Audio**
- AC’97 2.1 Compliant
- Advanced Wavetable Synthesizer
- DirectSound™ 3D Accelerator
- Full-duplex
- Built-In Microphone
- 2 Built-In Speakers

**Keyboard**
- “WinKey” Keyboard

**Pointing Device**
- Built-In TouchPad
Interface
- Two USB 2.0/1.1 Ports
- One Type-II PCMCIA 3.3V/5V Socket
- One Stereo Headphone-Out Jack
- One Monaural Microphone-In Jack
- One RJ-11 (V.90 K56flex™) Jack for Fax/Modem
- One RJ-45 Jack for 100M (Max) Fast Ethernet
- One External CRT Monitor Port
- One DC-in Jack

Power
- Full Range AC Adapter
  AC-Input 100~240V, 50~60Hz
  DC Output 20V, 2.5A (50W)
- One Standard Smart Lithium-Ion (1800mAH x 6 cells) Battery Pack with Gas Gauge

Indicators
- 7 LED Indicators (Power/Suspend, Battery, HDD, Caps Lock, Scroll Lock, Num Lock, Wireless LAN)

Buttons
- “Q” for screen rotation/power
- Tab
- Escape
- Scroll Up/Scroll Down/Enter
Environmental Spec

• Temperature
  Operating: 5°C ~ 35°C
  Non-Operating: -20°C ~ 60°C

• Relative Humidity
  Operating: 20% ~ 80%
  Non-Operating: 10% ~ 90%

Physical Dimensions

• 313mm (w) * 265mm (d) * 26.5/29.5mm (h) Min

Weight

• 2.2 Kg without Battery Pack

Optional

• PC Camera (factory option)
• Optional Smart Lithium-Ion (8 cell) Battery Pack
• 802.11b Wireless LAN Module with USB Interface
• External FDD with USB Interface (factory option)
• External CD-ROM/ CD-RW/ DVD-ROM/ Combo Drive with USB Interface
• PenPower Utility for Handwriting Recognition
• Car Adapter
Appendix B. Model B Specifications

Processor Options
• VIA Antaur 1.0 GHz

Memory
• Two 200-pin SODIMM Sockets, Supporting 266 MHz DDR Modules
• Memory Expandable up to 1GB (256/512 MB DDR Modules)

Core Logic
• CLE266CE

Security
• Security (Kensington® Type) Lock Slot
• BIOS Password

BIOS
• ACPI 4MB Flash ROM

LCD
• 14.1” XGA (1024*768) Flat Panel TFT
• LCD Swivel Hinge feature allows conversion between Notebook and Tablet Modes
Storage
- Easy Changeable 2.5" 9.5 mm (h) 20GB HDD ATA-33/66/100
- External FDD with USB (optional)
- External CD-ROM/ CD-RW/ DVD-ROM/ Combo Drive (optional)
- Built-in 4-in-1 Card Reader for the following formats:
  SD (Secure Digital)
  MMC (Multi Media Card)
  MS (Memory Stick)
  SM (Smart Media Card)

PC Card
- One Type-II PCMCIA 3.3V/5V Socket

Audio
- AC’97 2.1 Compliant
- Advanced Wavetable Synthesizer
- DirectSound™ 3D Accelerator
- Full-duplex
- Built-In Microphone
- 2 Built-In Speakers

Keyboard
- “WinKey” Keyboard

Pointing Device
- Built-In TouchPad
**Interface**
- Two USB 2.0/1.1 Ports
- One Type-II PCMCIA 3.3V/5V Socket
- One Stereo Headphone-Out Jack
- One Monaural Microphone-In Jack
- One RJ-11 (V.90 K56flex™) Jack for Fax/Modem
- One RJ-45 Jack for 100M (Max) Fast Ethernet
- One External CRT Monitor Port
- One DC-in Jack

**Power**
- Full Range AC Adapter
  - AC-Input 100~240V, 50~60Hz
  - DC Output 20V, 2.5A (50W)
- One Standard Smart Lithium-Ion (1800mAh x 6 cells) Battery Pack with Gas Gauge

**Indicators**
- 7 LED Indicators (Power/Suspend, Battery, HDD, Caps Lock, Scroll Lock, Num Lock, Wireless LAN)

**Buttons**
- “Q” for screen rotation/power
- Tab
- Escape
- Scroll Up/Scroll Down/Enter
Environmental Spec

- **Temperature**
  - Operating: 5°C ~ 35°C
  - Non-Operating: -20°C ~ 60°C

- **Relative Humidity**
  - Operating: 20% ~ 80%
  - Non-Operating: 10% ~ 90%

Physical Dimensions

- 313mm (w) * 265mm (d) * 26.5/29.5mm (h) Min

Weight

- 2.2 Kg without Battery Pack

Optional

- PC Camera (**factory option**)
- Optional Smart Lithium-Ion (8 cell) Battery Pack
- 802.11b Wireless LAN Module with USB Interface
- External FDD with USB Interface (**factory option**)
- External CD-ROM/ CD-RW/ DVD-ROM/ Combo Drive with USB Interface
- Car Adapter